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Anotace 

Výukový materiál je určen především pro studenty elektrotechnicky zaměřených škol,  

kteří potřebují navrhovat plošné spoje, kreslit schémata, simulovat rozvržení plošného 

spoje a tvořit si vlastní pouzdra pro součástky. Je zde zmíněno něco o historii plošných 

spojů, různých alternativách návrhu a provedení. Práce je vytvořena formou webové 

prezentace, obsahující lekce s návody, animace, úkoly k ověření pochopení probrané 

problematiky atd. Student, který poctivě projde všemi lekcemi a bude plnit zadané úkoly, 

by měl být schopen navrhovat plošné spoje moderním způsobem, jenž mu OrCAD nabízí. 
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Úvod 

Žijeme v době, kdy je elektronika součástí našeho každodenního života. Jistě každý 

vlastníme mobilní telefon, rádio, počítač a spoustu dalších zařízení, které nám usnadňují  

a zpříjemňují život. Pokud tato elektronická zařízení rozebereme, zjistíme, že všechny 

součástky jsou osazeny na jakési destičce (Obrázek 1, Obrázek 2). Ta obsahuje převážně 

měděné cesty a nazýváme ji deskou plošného spoje. Tudíž desky plošných spojů můžeme 

nalézt všude kolem nás. 

První pokusy o něco, co by se vzdáleně podobalo DPS, byly již v druhé polovině  

19. století. Desky dnešní podoby začaly vznikat ve 30. letech 20. století. Tehdy totiž 

Charles Ducas
1
 přišel s nápadem, jak nanést vodivý materiál na izolační podložku. 

Prováděla se celá řada pokusů, jež měly určit nejvhodnější vodivý materiál. Nakonec  

se jako nejvhodnější vodivý materiál zvolila měď, která se kvůli dobrým vlastnostem 

zachovala až do dnešní doby. 

První zařízení, které využívalo desku plošného spoje, bylo elektronkové rádio. Později  

se desky plošných spojů začaly osazovat polovodičovými součástkami, které se stále vyvíjí 

a zmenšují. Vznikají složitá zařízení obsahující velkou spoustu součástek. Cílem výrobců 

elektroniky je své produkty minimalizovat, aby zabíraly co nejmenší plochy. Ale jak 

efektivně umístit stovky součástek? Proto vznikají vícevrstvé plošné spoje, mající třeba 

osm vrstev. Jedná se zjednodušeně o střídání vodivého a izolačního materiálu. V běžných 

„domácích“ podmínkách je výroba vícevrstvých plošných spojů nemožná. Pokud by  

se jednalo jen o jednu nebo dvě vrstvy, je realizace s drobným technickým vybavením 

reálná. 

V minulosti byla výroba plošných spojů velice náročná. Pokud se jednalo o jednodušší 

zapojení, stačily spoje nakreslit lihovým fixem na laminátovou desku, potaženou mědí 

(kuprextit). Nyní díky rozvoji osobních počítačů již zvládneme vytvořit návrh zapojení 

elektronického schématu pohodlně přímo v počítačovém programu a následně provést 

generování patřičného plošného spoje pro námi zvolené zapojení. Existuje celá řada 

počítačových programů, které nám tyto funkce umožňují. Nejpoužívanější jsou Eagle
2
 

a OrCAD
3
. Ceny těchto programů se pohybují v řádech desítek tisíc. 

Zkratka OrCAD znamená Oregon + CAD. První verze tohoto softwaru začaly vznikat  

po roce 1985. V současné době je OrCAD vlastněn společností Cadence Design Systems, 

která je celosvětově uznávána. Společnost uvolňuje celou řadu licenčních verzí. Existují 

např. verze pro studenty, které jsou velkým přínosem pro začínající návrháře. 

Program OrCAD je tvořen několika, nezávisle na sobě oddělenými prostředími. Pro naši 

činnost se budeme zabývat Capture a Layout. V prvním z těchto prostředí se seznámíme, 

                                                 
1
Desky plošných spojů: http://www.madehow.com/Volume-2/Printed-Circuit-Board.html 

2
Alternativy návrhu EAGLE: http://www.eagle.cz/ 

3
Stránky OrCADu: http://www.cadence.com/us/pages/default.aspx 

http://www.madehow.com/Volume-2/Printed-Circuit-Board.html
http://www.eagle.cz/
http://www.cadence.com/us/pages/default.aspx
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jak kreslit námi požadovaná zapojení, vybírat vhodné součástky z knihoven nebo vytvářet 

nové součástky podle příslušných českých státních norem. V druhém prostředí si ukážeme, 

jak ze schématu zapojení získat už konkrétní návrh plošného spoje, jak využívat knihovny 

pouzder pro součástky, tvořit nové knihovny, jak generovat osazovací výkres. Ukážeme si 

možnosti volby generování cest plošných spojů. Seznámíme se s nástroji, které konkrétní 

prostředí umožňují. 

 

Obrázek 1 – Horní pohled na osazenou DPS 

 

 

Obrázek 2 – Dolní pohled na osazenou DPS 

 

Na konci bychom měli mít k dispozici řadu výkresů. Na prvním z nich schéma zapojení, 

druhém osazovací plánek a na třetím námi navržené cesty pro proud mezi součástkami. 

Pokud budeme tisknout osazovací výkres a zhotovovat plošný spoj v domácích 
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podmínkách, doporučuje se, aby byl osazovací výkres
4
 tištěn na co nejtenčí papír. Tento 

papír by měl mít i určitou průhlednost. Proto je nejvhodnější volit pauzovací papír, který  

je možné sehnat v lépe vybaveném papírnictví. [2], [7], [10] 

1 Instalace softwaru OrCAD na operační systém Windows 7 

Existuje celá řada distribucí programu OrCAD. Některé jsou určeny pro systémy pracující 

na linuxovém jádře, jiné zas pro systémy Windows. V této části si ukážeme instalaci 

OrCAD verze 9.2.3 pro Windows. 

Nejprve vsuneme paměťové médium, na kterém máme danou distribuci, a spustíme 

instalační soubor s příponou *.exe. Někdy se instalátor spustí sám a rovnou  

se zobrazí okno Welcome (uvítací okno). Zde je uživateli doporučeno, aby ukončil 

všechny běžící programy, než začne instalace. Dále se zde nachází zmínka, že nepovolené 

kopírování nebo distribuce tohoto programu nebo jeho části může mít za následek závažné 

občanskoprávní a trestní postihy. Abychom mohli pokračovat, musíme kliknout na Next 

(další) v uvítacím okně. 

Na následujícím okně je nutné si pročíst licenční podmínky. Pokud jsou akceptovatelné, 

musí uživatel pro pokračování v instalaci kliknout na tlačítko Yes. V případě nesouhlasu 

na No. Rovněž je zde možnost návratu o krok zpět (Back). 

Pro pokračování v instalaci je nutné zadat licenční číslo, které jsme si zakoupili s daným 

produktem, a kliknout na Next. Licenční číslo nalezneme na balení s dodávaným 

softwarem. Jedná se o poměrně drahý software, jehož cena dosahuje několika desítek tisíc 

korun. 

Na dalším okně je nutné vyplnit jméno (Name) člověka, který bude danou licenci užívat,  

a společnost (Company), pro kterou daný uživatel pracuje. Po vyplnění je nutné kliknout  

na Next. 

Následující okno jen shrnuje informace o konkrétním uživateli. Uživatel je zde vyzván, 

aby s uvedenými informacemi souhlasil klikem na Yes. 

V dalším kroku uživatel vybírá složku, do které má dojít k instalaci. Složku vybírá klikem 

na Browser. Případně je mu umožněn návrat na předchozí krok. Nejvhodnější je volit 

složku na disku C. Usnadní nám to pozdější orientaci v programu a pohodlnější práci. 

Instalátor přidá ikonu programu do programové složky, která je uvedena níže. V tomto 

kroku je dobré nechat přednastavení cesty od výrobce programu, a tudíž stačí kliknout  

na Next a přesunout se do dalšího okna. 

Nyní budeme vyzváni, jestli máme instalovat kreslicí balíček Visual CADD. Zde dáme 

přeskočit, čili provedeme kliknutí na Ne. Balíčky tím pádem nebudou instalovány. 

                                                 
4
 Ve slangovém významu: „osazovák“ 
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V kroku na následujícím okně má dojít k určení cesty pro výchozí pracovní adresář.  

Po zvolení adresáře pokračujeme klikem na Next. Je vhodné volit adresář na disku,  

na kterém máme instalovaný operační systém. 

Dalším oknem instalátor oznamuje, že má dostatek informací k zahájení instalace. 

Upozornění vezmeme na vědomí a instalaci zahájíme klikem na Next. Nějakou dobu 

čekáme, než dojde k nainstalování stěžejních částí programu, jenž tvoří vlastní instalaci 

OrCADu. 

Dále jsme vyzváni, zda chceme asociovat přípony s produktem, který právě instalujeme. 

Zvolíme na obou Ne. Vyhneme se tím zbytečným pozdějším problémům s dalšími okny  

a nastavováním. 

V předposledním kroku nás instalátor upozorňuje na nutnost mít na daném počítači 

nainstalovaný Internet Explorer a Acrobat Reader. Klikneme na OK, že si sdělení 

uvědomujeme, a přejdeme k poslednímu kroku. 

Na posledním obrázku k instalaci klikneme na Finish, čímž instalaci ukončíme. 

Zaškrtávací políčka k zobrazení dokumentace, aktualizacím a poznámkám k produktu 

necháme prázdná. Po kliknutí na: Start ►Všechny programy ► Orcad Unison Suite 

bychom měli být schopni námi používané aplikace spustit a pracovat s nimi (Capture, 

Layout). 

Praktická část obsahuje řadu screenů, ze kterých je možné získat kompletnější přehled  

o této instalaci. 

2 Nejvíce používané schématické značky 

Elektronika je umění. Během následujících lekcí se setkáme s celou řadou polovodičových 

součástek. Je nezbytné, aby odborník, znalý v návrzích plošných spojů, alespoň věděl,  

co kreslí a pro koho to vlastně kreslí. V následující tabulce (Tabulka 2) je přehled 

nejpoužívanějších součástek. Tyto součástky jsou kresleny v souladu s ČSN. V knihovnách 

programu OrCAD se můžeme setkat i se součástkami, u nichž je schématické značení 

v naší zemi nepoužitelné (Tabulka 1). Je to způsobeno odlišnými normami pro kreslení. 

Příkladem takové součástky může být rezistor nebo kondenzátor. 
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Tabulka 1 – Odlišné normy pro značení rezistoru a kondenzátoru 

  

+

 

+

 
 

Tabulka 2 – Nejpoužívanější schématické značky 

 

Rezistor 

+

 

Elektrolytický kondenzátor 

 

Kondenzátor 

-
+

 

Usměrňovač 

1
3

2

 

Lineární potenciometr 

1

 

Svorka 

1

6

2

5

4

 

Optočlen 

 
Zenerova dioda 

 

Uzemnění 

 

Tranzistor NPN 
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Tranzistor PNP 

 
Dioda 

A
1
2

B
1
3

z
u

9

Q
8

C
T
C

2

R
T
C

1

R
S

3

M
R
S
T

6

M
O
D
E

1
0

Q
/Q

4 g
g

5

k
7

jj
1
1

h
1
4

 

Integrovaný obvod 4541 

VREF
8

RT/CT
4

VFB
2

COMP
1

ISENSE
3

GND
5

VCC
7

OUT
6

 

Integrovaný obvod UC3842N 

 
Pojistka 

 

Unipolární tranzistor 

I
1

O
3

6
2

 

Integrovaný obvod 78L05 

-

+5

6
7

8

4

 

Operační zesilovač 

2

7
5

8

116
 

Transformátor 
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3 Základní rozvržení 

3.1 Normy a přehled 

Každý návrhář, pracující s prostředím OrCAD, využívá jen určitou jeho část. Např. návrhář 

základních desek pro osobní počítače bude pracovat s poměrně složitějšími součástkami 

než návrhář rádia. Podle účelu užití má Capture různé knihovny symbolů a schématických 

značek. Jedná se o tisíce nejrůznějších součástek. My se v těchto lekcích zaměříme  

na knihovny, v nichž se značky elektrotechnických součástek řídí instrukcemi Mezinárodní 

elektrotechnické komise. Tyto knihovny se nazývají IEC. 

Existuje celá řada ČSN pro kreslení elektrotechnických součástek. V současné době, kdy  

je Česká republika součástí Evropské unie, se na dodržování norem zvlášť dbá. Proto  

se ČSN řídí i doporučením IEC. Avšak ne každý se v novém značení vyzná, a tak občas 

dochází ke značení dle dřívějších zvyklostí, což pro někoho znemožňuje čitelnost 

schématu. Zvlášť pro mladé generace obyvatelstva s technickým zaměřením. 

V praxi dochází k tomu, že většina firem si definuje vlastní okruhy značení podle toho,  

co je pro ni důležité. Vytvářejí si i vlastní knihovny součástek, jež se využívají na daném 

pracovišti. 

Návrh schématu je vlastně založen na vyvolání námi konkrétní součástky z knihovny  

a umístění na ploše, kterou nám program poskytne. Dále je zapotřebí konkrétní součástky 

propojit vodiči a uzavřít elektrický obvod. Propojování nemusí být však vždy jen pomocí 

vodičů. Smíme využít například různé sběrnice, napájecí symboly a další. Program dovede 

i odstraňovat formální chyby vzniklé při propojování součástek, jež při návrhu vznikly. [4] 

Pokud je schéma nakresleno, je možné výkres poskytnout k dalšímu zpracování.  

Např. vytvořit netlist nebo tisknout na tiskárně. 

Na následujícím obrázku (Obrázek 3) je možné vidět čtyři základní pracovní okna, která  

se objeví po spuštění a otevření programu: 

1. Schematic Page Editor tool palete – umožňuje uživateli si vybírat součástky  

z knihoven a přepínat různé nástroje. 

2. Schematic Page Editor – slouží uživateli k tvoření a rozvržení návrhu schématu. 

3. Project Manager – jeho úkolem je řídit celý projekt. 

4. Toolbar – lišta obsahující nejpoužívanější nástroje pro práci. 
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3.2 Struktura projektu 

Projekt je tvořen pomocí stromové struktury. Má dvě části s příponami *.opj a *.DSN,  

z nichž první značí projekt schématu a druhá jeho návrh. Je naprosto nezbytné, aby  

k projektovému souboru nevedla cesta s diakritikou. V opačném případě uživatel stráví 

dlouhé hodiny bádáním za účelem odhalit tuto banální chybu. 

 
Obrázek 3 – Základní okno 

 

3.3 Popis některých tlačítek 

V následujících tabulkách (Tabulka 3, Tabulka 4) jsou popsána klíčová tlačítka, která 

budeme během návrhu potřebovat. Je poměrně dost důležité znát významy těchto tlačítek, 

neboť bez nich bychom nebyli schopni nakreslit ani jedinou součástku, natož rozsáhlý 

projekt, jenž je cílem. 

 

Tabulka 3 – Ostatní tlačítka 

 
přepnutí do okna pro Managera projektu 

 
různé druhy zvětšování 

 
kreslení jen v rastru 

 
kreslení i mimo rastr 

 
okno pro výběr schématických značek 
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Tabulka 4 – Tlačítka v liště Schematic page editor tool 

 
výběr objektů – kláves S – Select 

 
vkládání součástek – P – Part 

 
propojování vodiči – W – Wire 

 
pojmenování vodičů – N – Net Alias 

 
propojování sběrnicemi – B – Bus 

 
spoj na vodiči – J – Junction 

 
vstup vodiče do sběrnice – E 

 
vyvolání značky napájení 

 
vyvolání uzemňování 

 
hierarchický blok 

 
hierarchický port 

 
hierarchický pin 

 
připojení schématických stránek 

 
nezapojený vývod 

 
pro kreslení neelektrických prvků 

 

3.4 Založení nového projektu 

Chceme-li dobře navrhovat plošné spoje, musíme si nejprve při zakládání projektu správně 

nastavit prostředí, ve kterém budeme pracovat. 

Zakládání projektu bych rozdělil do několika fází (Obrázek 4): 

1. Spustíme Capture. 

2. Z nabídky menu vybereme: File ► New ► Project. 

3. Do kolonky Name napíšeme jméno našeho projektu bez diakritiky. 

4. Musíme zvolit typ projektu. V našem případě to bude PC Board Wizard. 

5. Do kolonky Location nastavíme umístění projektu. Můžeme procházet i disk 

pomocí tlačítka Browse. 

6. V dalším kroku je nám umožněno přidávat potřebné knihovny. 

7. Projekt je zobrazen v manažeru projektu a je připraven k použití. 
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Obrázek 4 – Okno pro nový projekt 

 

V následujících dvou oknech se uživatel pouze prokliká na další. Je důležité, aby složka, 

do které se projekt uloží, neobsahovala též diakritiku. V opačném případě vzniká 

nepořádek na disku. Celý tento postup je možné vidět na krátkém shrnujícím videu a je 

možno si ho stáhnout v přiloženém balíčku. [3], [5] 
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4 Kreslení schématu 

V předchozí části jsme si ukázali, jak si založit prázdný nový projekt. Nyní si ukážeme 

způsob kreslení pomocí značek, které jsou již v knihovnách OrCADu. Knihovnu  

se schématickými značkami vyvoláme klikem na ikonu Place Part nebo stiskem klávesy 

P. Otevře se nám okno (Obrázek 5). Knihovny, které máme načteny, se nachází v rámečku 

Libraries. Knihovny můžeme přidávat klikem na Add Library (platí i pro vlastní 

knihovny) nebo odstraňovat z výběru Remove Library. Doporučuji, pokud není cílem 

tvořit vlastní knihovny, aby se po vyvolání Add Library vybraly tahem všechny knihovny 

a kliklo na Otevřít. Tím se všechny knihovny přidají do rámečku Libraries. Knihovny, 

které jsou dodávány s aplikací OrCAD, většinou nalezneme na disku: 

C:\Cadence\Orcad_9.2.3\tools\capture\library. Knihovny zde mají příponu *.OLB. Takže 

celý název knihovny může vypadat třeba takto: MojeKnihovna.OLB. Většinu základních 

součástek však najdeme v knihovně IEC.OLB.  

Pokud vyžadujeme jednotlivé součástky, píšeme jejich identifikaci do rámečku Part. 

Pokud je součástka nalezena v knihovnách, zobrazí se nám její značení jako  

na obrázku. Pak stačí jen odsouhlasit a součástka se přenese do projektu (část Schematic 

Page Editor). Jakmile součástku odsouhlasíme, stačí s ní „klikat“ v části Schematic Page 

Editoru. Kolikrát a kam klikneme, tolikrát se nám daná součástka přenese. Pokud  

ve výběrovém módu klikneme pravým tlačítkem na součástku, otevře se nám roletové 

menu, ve kterém můžeme se součástkou rotovat (Rotate) nebo ji převracet (Mirror). 

Abychom stále neklikali stejné součástky, výběr ukončíme stiskem klávesy ESC. Nyní 

můžeme jít vybírat další součástku. Pokud nás zajímá počet obvodů v jednom pouzdře, 

nalezneme ho v rámečku Packaging.  

Součástky je možné kopírovat v části Schematic Page Editoru stiskem CTRL+C a vkládat 

CTRL+V. Pokud máme více součástek stejného druhu, je nutné dbát na odlišné číslování, 

případně značení. Číslování se uvádí vždy nad značením. Původní hodnoty přepíšeme 

dvojklikem na původní hodnotu. Součástky můžeme vybírat jednotlivě nebo plošně. 

Jednotlivě stačí kliknout na součástku pravým tlačítkem myši, případně stisknout CTRL  

a přidávat do výběru další součástky. Nebo plošně stiskem CTRL+A. Další možností je: 

Edit ► Select All. Výběr se dá zrušit klikem levého tlačítka myši mimo objekt. 

Takto vytvořené součástky je nutné propojit. Provádí se to pomocí ikony Place wire nebo 

písmenem W. Chceme-li kreslit kolmo, stiskneme klávesu SHIFT a táhneme z jednoho 

propojovacího bodu do druhého. Pokud bychom klávesu neměli stisknutou, OrCAD by 

cesty tahal pod pravými úhly. Je však možné trasy měnit klikem a tahem za jednotlivé 

hraniční uzly. Pokud se nám vodiče spojují, spojení je prováděno uzly. Pokud vývody 

nejsou zapojeny, značí se křížkem. 
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Obrázek 5 – Výběr knihoven 

 

4.1 Úprava schématických značek a jejich popisů 

Ke každé schématické značce jsou přiřazeny vlastnosti a parametry. Chceme-li přistoupit  

do seznamu jejich vlastností, klikneme levým tlačítkem na součástku. Jakmile změní 

barvu, klikneme pravým tlačítkem na součástku a ze zobrazeného dialogu zvolíme Edit 

Properties. Objeví se okno Property Editor. V části Parts můžeme najít uspořádané 

položky podle námi nastaveného filtru. Zde využijeme jen filtry Capture a Layout. 

V tabulce můžeme najít položku Value, která uvádí hodnoty součástek. Položku 

Reference, uvádějící identifikační nebo pořadové číslo součástky nebo položku PCB 

Footprint, jenž uvádí název pouzdra, které je pro danou součástku přiřazeno v dalším 

zpracování. Pokud zde chceme provádět změny, klikneme pravým tlačítkem na položku, 

kterou chceme změnit a vyvoláme z roletového menu Edit. 

 

 



22 

 

5 Knihovny schématických značek 

Všechny součástky, které jsou během kreslení potřeba, se nacházejí v knihovnách. 

Knihovny v části Capture mohou být dvojího typu. Buď jsou dodány spolu s OrCADem, 

nebo jsou manuálně vytvářeny jednotlivci a společnostmi. Nebudu znovu uvádět příponu 

knihoven, ale uvedu, jak se s nimi pracuje. Pokud máme knihovnu třeba na Flash discu, 

otevřeme ji ve spuštěném prostředí klikem na: File ► Open ► Library. Pokud chceme 

vytvářet novou knihovnu, postup je skoro stejný, jen mimo Open dáme New. Takže, 

klikneme na: File ► New ► Library. Seznam součástek a název knihovny se nám 

zobrazuje v Project Manageru. 

5.1 Úprava a tvorba nových součástek 

Pokud chceme součástku v knihovně upravit, klikneme na ni pravým tlačítkem v Project 

Manageru a vyvoláme Edit Part. Otevře se nám okno, ve kterém je součástka graficky 

zobrazena. Její editaci provádíme podle následujících ikon (Obrázek 6). Dají se zde měnit 

rozměry, přidávat texty, měnit počty pinů (pomocí Place pin). Chceme-li upravovat 

například typy pouzder nebo počet značek v pouzdře, slouží nám k tomuto účelu okno Edit 

Part Properties. Toto okno nám umožňuje komplexní editaci schématických značek, 

symbolů atd. V případě, že již máme součástku vytvořenou, se na její Edit Part 

Properties dostaneme: Options ► Package Properties. Musíme však mít aktivní okno 

grafického rozhraní. Pokud však tvoříme novou součástku, dostaneme se na okno  

po kliknutí pravým tlačítkem na součástku v Project Manageru a vyvoláním New Part. 

Po vyplnění tabulek se nám otevře nové okno grafického rozhraní, ve kterém si součástku 

nakreslíme. 

 

Obrázek 6 – Tlačítka editace (Tool Palette) 

 

5.2 Přesun a kopírování mezi knihovnami 

Jedním ze způsobů tvoření nových knihoven je přesun mezi knihovnami. Je naprosto 

nezbytné, aby každá knihovna měla vlastní okno. Knihovna, do které se přesouvá, musí 

mít aktivní okno. Přesun probíhá klikem levého tlačítka na požadovanou součástku, jež má 

být přesunuta, a při stisklém levém tlačítku přesunuta na ikonu v nové knihovně (ikona  

s hradlem). Dalším způsobem tvoření knihoven je kopírování z Design Cache 

v Project Manageru. Pro tento postup je podstatné, aby součástky byly zobrazeny  

v Schematic Page Editoru (třeba z jiných knihoven). Tyto součástky mají svoji 

reprezentaci v Project Manageru v části Design Cache. Pro kopírování pak už jen stačí 

kliknout levým tlačítkem na požadovanou součástku, jež má být přesunuta,  

a při stisknutém levém tlačítku přetáhnout do nové knihovny na ikonu s hradlem. 
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Významy jednotlivých částí Part Editoru (Obrázek 7): 

1. Name – uvádí se katalogová hodnota schématické značky. 

2. Part Reference Prefix – uvádí označení součástky. 

3. PCB Footprint – uvádí název pouzdra. 

4. Create Convert View – umožnění tvořit odlišného grafického zástupce. 

5. Parts per Pkg – počet značek v daném pouzdře. 

6. Part Numbering – nastavení typu značení pro větší množství součástek v pouzdře. 

7. Pin Number Visible – viditelná čísla pinů. 

 

Obrázek 7 – Part Editor 
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6 Tvorba netlistu 

Abychom mohli s nakresleným elektrotechnickým schématem dále pracovat (vytvářet 

pouzdra pro součástky, osazovací výkresy,…), musíme výkres převést na společný formát 

dat s příponou *.MNL. Nejprve je nutné mít aktivní okno Project Manager a v něm 

vybrán soubor s příponou *.DSN. Na horní liště zvolíme Tools a ve výběru Create Netlist. 

Otevře se okno Create Netlist (Obrázek 8). Zde v horní části zvolíme kartu Layout 

a zaškrtneme Run ECO to Layout. Je to kvůli komunikaci plošného spoje se schématem.  

 

Obrázek 8 – Tvorba netlistu 

 

Dále zaškrtneme User Properties are in inches (jednotky palce). Důvodem tohoto kroku  

je velká podpora pouzder v palcích. V části Netlist File máme možnost měnit název  

a umístění výstupního souboru. Nesmíme však měnit příponu souboru tj. MNL. Pokud 

necháme umístění do složky, ve které máme nakreslen výkres, soubor nalezneme v okně 
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Project Manager v části Outputs. Se souborem s příponou MNL se bude pracovat v další 

části OrCADu, což je Layout. [3] 

7 Test po části Capture 

Na obrázku (Příloha A) je návrh elektronického schématu nabíječky na automobil. Úkolem 

je toto schéma překreslit v prostředí OrCAD. Jedná se o složitější projekt, u kterého  

je nutné si vytvořit i pár vlastních součástek. Správnost řešení si můžete ověřit 

v přiloženém projektu. [11] 

8 Návrh plošných spojů 

V předchozí části jsme se zabývali tvorbou elektronického zapojení. V jednotlivých 

krocích jsme si ukázali vše, co je třeba k vytvoření správného návrhu. V této části 

se budeme zabývat už konkrétním výstupem plošného spoje. Pro návrh plošného spoje 

využijeme Layout. V tomto prostředí nás čeká velká spousta úkonů, které by nás měly 

dovést k očekávanému cíli. Abychom mohli vůbec navrhovat už konkrétní výkres, budeme 

potřebovat výkres s příponou *.MNL, který jsme si vygenerovali v předchozí části. V této 

části se seznámíme tedy s vytvářením pouzder pro naše součástky, definováním ohraničení 

DPS, vedením spojů, rozmísťováním součástek a spoustou dalších podstatných rad  

a doporučení, jako mohou být exporty dat do jiných formátů. 

Program Layout je špičkový nástroj, se kterým by měla být schopna pracovat většina 

specializovaných středisek, zabývajících se konkrétní tvorbou plošných spojů.  

Než se pustíme do načtení souboru s příponou MNL, čili netlistu, musíme si nejprve 

nastavit, do kolika vrstev budeme případně plošný spoj kreslit barvy jednotlivých vrstev  

a jednotky, ve kterých se má zobrazovat. Uživatel má možnost si svoje definované 

nastavení uložit a později aplikovat na další výkresy. Soubor má příponu *.tch. 

8.1 Pracovní prostředí 

Program budeme ovládat pomocí příkazů v části Menu a lišty nástrojů, ve které jsou 

obsaženy nejpoužívanější nástroje. V tomto prostředí se dají využívat i klávesové zkratky, 

což ale nepovažuji za prioritní. 

 

Obrázek 9 – Ovládací panel v Layout 
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Na obrázku jsou vyznačeny funkce (Obrázek 9): 

1. Manipulace s polovodiči. 

2. Manipulace s ploškami k pájení. 

3. Manipulování s objekty. 

4. Manipulování s texty. 

5. Propojování mimo navrhované schéma. 

6. Manipulace s upozorněním na chyby. 

7. Definice barev. 

8. Kontrola pravidel návrhu během kreslení. 

9. Zobrazení vektorů propojení. 

10. Strojové pokládání spojů (plně automaticky). 

11. Tahání spojů s posunem. 

12. Korekce aktuálně nakreslených spojů. 

13. Jednoduché natažení spojů. 

14. Zkontrolování pravidel návrhu. 

8.2 Nastavení používaných knihoven pouzder pro Layout 

Pro každou součástku v námi navrženém schématu je potřeba pouzdro. Jedná se o prostor  

s vývody, který součástka obsadí na DPS. Nastavení knihoven provedeme klikem v části 

Menu na: Tools ► Library Manager ► Add. Otevře se nám okno pro vyhledání námi 

požadované knihovny součástek. Jako v prostředí Capture, tak i zde máme možnost tvořit 

vlastní knihovny pouzder, což je pro profesionální používání vhodné. 

8.3 Načítání netlistu pro Layout 

Nejprve klikneme na: File ► New. Program po nás bude chtít soubor s příponou *.tch.  

Je vhodné volit vždy výchozí nastavení tohoto souboru. Většinou je umístěn: 

Cadence\Orcad_9.2.3\tools\layout\data a nazývá se _default.tch. Pokud ho zvolíme, 

budeme aplikací vyzváni, abychom načetli netlist s příponou *.MNL. Po načtení netlistu 

zvolíme složku, do které se bude ukládat námi vytvořený plošný spoj s příponou *.MAX. 

Proběhne-li vše v pořádku (Příloha B), objeví se nám na ploše rozházené součástky.  

V případě chyby se zobrazí výpis (Obrázek 10). V průběhu práce se budou do stejné složky 

ukládat i rozpracované kopie. 
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Chyby při vytváření pouzder: 

1. Knihovna, kterou pro součástku potřebujeme, OrCAD nevidí. 

2. Odlišné značení vývodů v části Capture a vývodů v knihovně Layout. 

3. Název pouzdra pro danou součástku je uveden nesprávně. 

4. Pro schématickou značku je zvoleno pouzdro s menším počtem nožiček.  

V rychlosti se to dá odstranit zvolením pouzdra s větším počtem nožiček a později 

změnit. 

 

Obrázek 10 – Chyby při importu netlistu 

 

8.4 Nastavení vrstev 

U složitějších zapojení je možné kreslit cesty, případně nastavovat další vlastnosti  

do vrstev. Proč se určité návrhy takto kreslí, je zmíněno v úvodní části. Vrstvy se dají 

vybírat klikem do zeleného prostoru (Obrázek 9). Místo je označeno zeleně s nápisem 

TOP. V různých nastaveních, v tomtéž prostoru mohou být různé nápisy. Vlastnosti 

jednotlivých vrstev se dají nastavit klikem na: Tool ► Layer ► Properties. Toto 

nastavení se provede vždy na vybranou vrstvu. V našem případě TOP. Ve vlastnostech 

vrstev je nutné vždy zvolit Unused Routing (kreslení je zakázáno) a Routing Layer 

(kreslení je povoleno). V případě, že budeme chtít kreslit náš projekt celý do jedné vrstvy, 

je nutné, aby ve všech ostatních vrstvách bylo kreslení zakázáno. U vrstev je možné 

nastavit zobrazení a barvy. Okno, v němž se nastavení provádí, nalezneme přes: Options 

► Colors. 



28 

 

8.5 Jak nastavit rastr? 

Nastavení rastru je poměrně dost důležité. Chce si dobře promyslet a moudře zvolit typ 

rastru pro podmínky, zobrazení, vedení spojů, pro kovy (pájecí body), rotaci, polohy 

součástek a texty. Zvolené nastavení bude aplikováno na celý návrh DPS. 

Rastr nastavíme klikem na Options a vyvoláním Systém Setting. Další nastavení 

provedeme následovně: 

1. Display Units (zobrazovací jednotky) – Mils. 

2. Display Resolution (zobrazovací rozlišení) – 1. 

3. Increment – 90. 

4. Snap (uchopení) – 0 1'. 

5. Visible grid (zobrazení mřížky) – nastavit na 50. 

6. Detail grid (texty) – nastavit na 25. 

7. Place grid (polohy součástek) – nastavit na 50. 

8. Routing grid (vedení spojů) – nastavit na 25. 

9. Via grid (prokovy) – nastavit na 0. 

8.6 Jak nastavit pracovní plochu? 

Pracovní plochu nastavíme klikem na Options a vyvoláním User Preferences. Další 

nastavení provedeme následovně. V User Preferences dbáme, abychom měli zaškrtnuté: 

Enable Auto Pan (automatické posouvání obrazovky), Use Opaque Graphics (aby 

aktivní vrstva byla v popředí), Enable Copper Pour (umožnění rozlévání mědi),  

Use Poursfor Connectivity (plošky, které jsou propojeny mědí, se už nemusí propojovat 

vodičem), Activate Online DRC (stálá kontrola pravidel návrhu), Show Tooltips, 

Activate Auto Tool Select Mode, Move Free Vias With Components a Minimum 

Track Width to Display nechat nastaveno na 0. Nic víc nezaškrtávat. 

8.7 Izolační vzdálenosti 

Plošné spoje mohou být zhotovovány v odlišných technických podmínkách. Podle 

prostředí, kde bude plošný spoj fyzicky zhotoven, je nutné patřičně nastavit izolační 

vzdálenosti (Obrázek 11). Pokud chceme plošný spoj zhotovit do jedné až dvou vrstev,  

je vhodné nastavit izolační vzdálenost (Track to Via Spacing) na 12mils. Nastavení 

provedeme klikem na: Options ► Global Spacing. Ve sloupcích Track to Via  se dají 

údaje měnit plošně nebo jednotlivě. Pokud jde o plošný výběr, sloupec se vybere tahem  

při stisknutém levém tlačítku myši. Následný klik pravého tlačítky vyvolá tabulku, ve které  
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je možné údaje měnit. Pokud se však jedná o individuální změnu, postup s pravým 

tlačítkem se vyvolá jen na dané hodnotě. 

 

Obrázek 11 – Nastavení izolačních vzdáleností 

 

8.8 Psaní textů na DPS 

Občas se stává, že návrhář potřebuje na DPS umístit text, např. identifikační číslo desky 

nebo iniciály. Okno pro tvorbu nového textu vyvoláme: Tool ► Text ► New. Objeví  

se okno (Obrázek 12). V části Text String píšeme námi požadovaný text. Zaškrtávací 

políčko Mirrored nám umožňuje zrcadlit text, což je výhodné při některých technologiích 

výroby DPS. 

 

Obrázek 12 – Editace textu 
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9 Vedení spojů 

V programu Layout máme možnost volit mezi dvěma způsoby, jak vést spoje. Jsou  

to manuální a automatické vedení. U automatického obstarává veškerou práci počítač a dle 

různých kombinací vyhledává nejlepší rozmístění cest tak, aby se všechny cesty vešly  

na desku do námi zvoleného počtu vrstev. Naopak u manuálního vedení si musíme poradit 

s vlastními kombinačními schopnostmi. U složitějších realizací je volba tohoto způsobu 

naprosto nevhodná. Lze však kreslit část automatickým vedením a manuální použít pouze 

k dokreslení nebo modifikaci určité cesty. V obou případech je snaha vést cesty tak,  

aby nedocházelo ke křížení. Proto je vhodné volit rozmístění součástek bez zbytečného 

křížení vazeb. [6], [7] 

9.1 Manuální vedení 

U manuálního vedení spojů je třeba nejprve nastavit režim vedení spojů. Nastavení 

provedeme klikem na Option na hlavní kartě a následným výběrem Route Setting. Objeví 

se nám okno. V části Route Mode si zvolíme jeden z režimů vedení spojů  

s vlastnostmi. 

Pro zobrazení nástrojů (Tabulka 5) je nutné, aby bylo aktivní tlačítko strojového pokládání 

spojů nebo tlačítko pro korekci aktuálně nakreslených spojů (Obrázek 9). Strojové 

pokládání umožňuje ruční kreslení, případně kreslení klikem na požadovaný PIN 

součástky. Nástroje lze vybírat klikem pravého tlačítka na spoj, se kterým se má provést 

úprava. Chceme-li odstranit celý návrh plošného spoje, zvolíme: Auto ► Unroute ► 

Board. Takto se odstraňuje celý návrh i v automatickém vedení. 

Je možné se setkat s následujícími režimy: 

1. Add/Edit Route Mode – jednoduché vedení spojů (Spoje jsou prokládány přesně 

podle zadaných instrukcí návrháře.). 

2. Edit Segment Mode – korekce již vzniklých spojů. 

3. Shove Track Mode – spoje jsou vedeny s plně automatickým posunem. 

4. Auto Path Route Mode – spoje jsou automaticky prokládány. 

Možné vlastnosti režimů: 

1. Snap to Grid Routing – nastavení rastru je akceptováno spoji. 

2. Shove Components – součástky je možné posunout. 

3. Maximize 135 Corners – spoje jsou vedeny pod úhlem 45°. 

4. Drawing Metod – spoje je možné vést podle uživatelem definovaným úhlem. 

5. Allow Of-Grid Routing – vedené spoje neosahují rastr. 
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9.2 Automatické vedení 

Automatické vedení se provádí klikem na: Auto ► Autoroute ► Board. V úvodní části 

byla zmíněna důležitost manipulovat se součástkami pomocí tlačítka manipulace 

s polovodiči (Obrázek 9). Rotaci součástek je pak možné provést klikem pravého tlačítka 

na požadovanou součástku a vyvoláním Rotate. 

 

Tabulka 5 – Nástroje pro manipulaci se spoji 

End Command  skončení tažení spoje 

Finish F automatické skončení návrhu spoje 
Unroute Segment G odstranění jednoho segmentu 
Unroute D odstranění jednoho spoje 
Unroute Net Alt+D odstranění všech spojů zvoleného uzlu 
Change Width W změna šířky nyní taženého spoje 
Add Via V vložení prokovu 
Lock/Unlock L,Ctrl+L uzamčení nebo odemčení spoje 
Copy Ctrl+C kopie spoje, který je právě navrhován 
Segment S režim manipulace se segmentem (při editování 

spoje) 
Exchange Ends X prohození počátečního a koncového bodu při 

tažení spoje 
Tack Ctrl+T přepojení spoje do jiného místa ve stejném uzlu 
Snap To Grid  zapnutí a vypnutí rastru při vedení spojů 

135/90/AnyAngle/Curve  metody pro vedení spojů 

Change Via Type  změna použitého typu prokovu (lokální změna) 

 

9.3 Nastavení rozměrů pájecích bodů 

OrCAD umožňuje navrhovat rozměry pájecích bodů, případně jejich tvary. Tyto tvary  

a rozměry chce volit podle technických možností výroby. Např. není vhodné volit malé 

rozměry, pokud nebudeme mít vhodnou technologii výroby DPS, případně technologii  

pro osazování. Nastavení lze provést klikem na: Tool ► Padstack ► Select From 

Spreadsheet. [7] 

9.4 Obrys plošného spoje 

Jeho úkolem je vymezovat prostor DPS. Ohraničení je vhodné pro pozdější ořez. Pokud 

máme založen nový projekt, je nejprve nutné založit nový obrys: Tool ► Obstacle ► 

New. Pozdější editaci provádíme klikem: Tool ► Obstacle ► Properties. Objeví  

se okno, ve kterém je nutné nastavit Obstacle Layer, což je vrstva, do které návrhář umístí 

své ohraničení, a Width, jež nastavuje šířku ohraničení. [2] 
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10 Výstupní data 

Výstupní data jsou nutnou součástí pro osazení a zhotovení DPS. Výstupy těchto dat 

mohou vypadat různě. Návrhář musí nastavovat jednotlivé vrstvy a vlastnosti použitých 

vrstev dle nastavení. Data, která jsou výstupem, mohou být generována v nejrůznějších 

formátech (osazování, potisk …). Např. pro osazovací výkres zvolíme jinou vrstvu, než 

daný návrh plošného spoje. 

10.1 Nastavení vrstev pro výstup 

Nastavení vrstev (Obrázek 13) provedeme klikem na: Options ► Post Proces Setting ► 

Properties ► Print Manager. Volby Properties dosáhneme pravým klikem na některé 

zařízení – sloupec Device a následně volbou Properties. 

 

Obrázek 13 – Nastavení vrstev a jejich vlastností 

 

10.2 Barvy pro grafické výstupy 

Nastavení vrstev provedeme klikem na: Preview ► Options ► Color. Položku Options 

lze najít na ovládacím panelu. K volbě Preview se dostaneme totožným postupem jako  

k Properties. Zajímá-li nás pouze zobrazit výkres k tisku v dané vrstvě, klikneme pouze  

na Preview. Tisk v dané vrstvě zahájíme klikem na Plot to Print Manager, který 

se nachází na stejné kartě jako Properties. 
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11 Test po části Layout 

V přiloženém souboru test_layout.zip je návrh elektronického schématu z minulého bloku. 

Úkolem je z tohoto schématu vytvořit netlist a vytvořit z něho kompletní návrh DPS 

(Obrázek 14). Hotový projekt je přiložen ve webové části. 

 

Obrázek 14 – Výstupní návrh z Layout 
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12 Webová část práce 

Kvůli přehlednosti výukového materiálu byla vytvořena webová prezentace, která 

upřesňuje a shrnuje probrané kapitoly. Na rozdíl od tištěné podoby je v ní možné 

prezentovat praktická videa, což je velice názorné. Podobně jako v tištěné podobě i zde  

je výuka strukturována po lekcích, avšak pojetí je spíše praktické. 

12.1 Jak to vlastně funguje? 

Webová aplikace má úvodní stránku (Obrázek 15), na kterou se uživatel dostane. V horní 

části této stránky se můžete zaregistrovat, změnit heslo a přihlásit. Přihlášeným uživatelům 

bude umožněno prohlížet obsah stránek, stahovat soubory, psát chat a email správci. 

Všichni uživatelé mají možnost hodnotit obsahovou i grafickou podobu stránek. 

 

Obrázek 15 – Ukázka webové aplikace 

 

Podstatu webové aplikace popisují diagramy: 

1. Activity diagram pro anketu (Příloha C). 

2. Usecase diagram (Příloha D). 

3. Class diagram pro odesílání emailu (Příloha E). 

4. Class diagram pro aplikaci (Příloha F). 

5. Rich Picture diagram (Příloha G). 
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13 Část v NetBeans 

13.1 CSS 

 Tento adresář obsahuje grafický 

podklad pro statistiku – bar 1.gif, bar 

2.gif a bar3.gif. Pozadí a obrázek 

hlavičky na webu – obr.jpeg. Soubor 

podpora.css obsahuje jednotlivé styly  

a stará se o vizuální efekt. 

13.2 Pikcr a soucastky 

Zde jsou uloženy veškeré obrázky,  

které byly na webu použity jako část 

prezentace. 

13.3 Stazeni 

Zde jsou uloženy veškeré soubory,  

které jsou na webu k dispozici  

ke stažení. 

13.4 Include 

Zde jsou uloženy veškeré části webu, 

jako jsou jednotlivé stránky 

(registrace, chat, diskuse, lekce, …). 

Adresář PEAR zajišťuje fungování 

webového emailu. 
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13.5 Výběr klíčových částí 

Mezi podstatné části práce patří: 

1. Cvika.php – zde jsou obsaženy veškeré materiály ke stažení. 

2. Diskuse.php – v této části je nastavení emailu a diskuse. 

3. Lekce.php – tato část obsahuje lekce o OrCADu. 

4. Pripojeni.php – zajišťuje propojení s databázovým serverem. 

5. Reg.php – zajišťuje registraci. 

6. Uvod.php – stránka, která se zobrazí všem (i neregistrovaným uživatelům). 
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14 Databázová část práce 

Pro databázovou část práce byl zvolen databázový server Oracle10g. Jedná se o poměrně 

rozsáhlý a kvalitní systém. Jeho využití je celkem široké. Nachází uplatnění například 

v bankách, u Českých drah a v mnoha dalších institucích. Pro svůj návrh jsem využíval 

okleštěnou verzi omezenou asi na 25 tabulek. S tabulkami se dá na serveru pracovat buď 

pomocí webového rozhraní, nebo pomocí klienta, kterým může být SQLdeveloper.  

Ve velkých společnostech může obsahovat i několik stovek tabulek. Existují i jiné 

databázové systémy např. od švédské firmy MySQL, na který časem také přejdu. [8] 

14.1 Podstatné části kódu 

 

Tabulka 6 – Ukázky důležitých částí z kódu PHP 

session_start(); // zapne session 
ini_set('display_errors', 0); // skryje php chyby 
if (!isset($_SESSION["pripojen"])) { // ověří přihlášení uživatele 
    $_SESSION["pripojen"] = fALSE; 
} 
date_default_timezone_set("Europe/Berlin"); // nastaví datum 
if (!isset($_SESSION["uz_je"])) { 
    $_SESSION["uz_je"] = false; 
} 
include_once './include/pripojeni.php'; // připojení a odhlášení webu vůči databázi 
if (isset($_POST['odhlaseni'])) { 
    $_SESSION["pripojen"] = fALSE; 
    $_SESSION["id_uziv"] = null; 
    $_SESSION["uziv"] = ''; 
    $_SESSION["uz_je"] = false; 
} 
$host = $_SERVER['HTTP_HOST']; // přesměrování při přihlášení 
            $uri = rtrim(dirname($_SERVER['PHP_SELF']), '/\\'); 
            $extra = 'index.php?set=' . $set; 
header("Location: http://$host$uri/$extra"); 
<title>Předchůdci PC</title><!-- zobrazí hlavičku, html kód--> 
if (isset($_POST['prihlaseni']) && (!$_SESSION["pripojen"])) { //zobrazí chybové hlášení                    

echo "<p class=\"warrning0\"> Zadaný Login a Heslo neexistuje! </p>"; 
                } 
<?php 
$user = 'stxxxxx'; // zajišťuje připojení do databáze 
$pass = 'xxxx';// heslo 
$host = 'sql101.upceucebny.cz/oracle10'; 
$charset = 'UTF8'; 
$c = oci_connect($user,$pass,$host,$charset); 
if (!$c){ 
    echo 'Nepovedlo se navazat spojeni s DB'; // zobrazí chybové hlášení při připojení 
 
    $e = oci_error(); 
var_dump($e); 
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} 
?>  
if (!empty($_POST['login'])) { // ověření všech polí 
            $login = $_POST['login']; 
        } else { 
            $tab1 = true; 
            $messageNapiste = "Nejsou vyplněna všechna pole";  
        } 
if (!empty($_POST['zvire'])) { //ověření zvířete 
            $zvire = $_POST['zvire']; 
        } else { 
            $tab2 = true; 
            $messageNapiste = "Nejsou vyplněna všechna pole"; 
        } 
if (!empty($_POST['heslo'])) { // ověření hesla 
            $heslo = $_POST['heslo']; 
        } else { 
            $tab3 = true; 
            $messageNapiste = "Nejsou vyplněna všechna pole"; 
        } 
$messageNapiste = "Zmeneno heslo u id: $UzID"; //zajistí změnu hesla 
switch ($vol) { // anketa 
            default : 
            case 1: 
                $date = date("d.m.y"); 
                $stid = oci_parse($c, "insert into 

anketa(id_ankety,ID_vytvoritele,datum_vytvoreni,zaznam) values 

(1,1,TO_DATE('$date','DD.MM.YY'),1)"); 
oci_execute($stid); 
oci_commit($c); 
                echo '1'; 
break; 
            case 2: 
                $date = date("d.m.y"); 
                $stid = oci_parse($c, "insert into 

anketa(id_ankety,ID_vytvoritele,datum_vytvoreni,zaznam) values 

(1,1,TO_DATE('$date','DD.MM.YY'),2)"); 
oci_execute($stid); 
oci_commit($c); 
                echo '2'; 
break; 
            case 3: 
                $date = date("d.m.y"); 
                $stid = oci_parse($c, "insert into 

anketa(id_ankety,ID_vytvoritele,datum_vytvoreni,zaznam) values 

(1,1,TO_DATE('$date','DD.MM.YY'),3)"); 
oci_execute($stid); 
oci_commit($c); 
                echo '3'; 
break; 
            case 4: 
                $date = date("d.m.y"); 
               $stid = oci_parse($c, "insert into 

anketa(id_ankety,ID_vytvoritele,datum_vytvoreni,zaznam) values 
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(1,1,TO_DATE('$date','DD.MM.YY'),4)"); 
oci_execute($stid); 
oci_commit($c); 
                echo '4'; 
break; 
        } 

 

15 Syntaxe některých použitých databázových objektů 

 

15.1 Indexy 

CREATE INDEX Honza.Index6 ON Honza.Pocitadla (id_pocitadla) 

/ 

CREATE INDEX Honza.Index7 ON Honza.Pocitadla (id_login,id_uzivatel) 

/ 

CREATE INDEX Honza.Index8 ON Honza.Pocitadla (vyber) 

/ 

CREATE INDEX Honza.Index4 ON Honza.Obrazky_stranky (ID_textu-stranky) 

/ 

15.2 Tabulky 

CREATE TABLE Honza.Pocitadla( 

id_pocitadlaNumber NOT NULL, 

  vyber Number, 

id_uzivatelNumber NOT NULL, 

id_loginNumber NOT NULL 

) 

/ 

CREATE TABLE Honza.Anketa( 

id_anketaNumber NOT NULL, 

cislo_volbyNumber, 

id_uzivatelNumber NOT NULL, 

id_loginNumber NOT NULL 

) 
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15.3 Příklady sekvencí pro indexování tabulek 

CREATE SEQUENCE Honza.seq_login 

 INCREMENT BY 1 

 START WITH 1 

 NOMAXVALUE 

 NOMINVALUE 

 NOCACHE 

/ 

 

CREATE SEQUENCE Honza.seq_obrazky_stranky 

 INCREMENT BY 1 

 START WITH 1 

 NOMAXVALUE 

 NOMINVALUE 

 NOCACHE 

/ 

 

CREATE SEQUENCE Honza.seq_emails 

 INCREMENT BY 1 

 START WITH 1 

 NOMAXVALUE 

 NOMINVALUE 

 NOCACHE 

/ 

15.4 Triggery (spouštěče pro automatické číslování primárních klíčů  

v tabulkách) 

CREATE TRIGGER Honza.triger_pocitadla 

  BEFORE INSERT 

  ON Honza.Pocitadla 

 FOR EACH ROW 

  BEGIN 

selectseq_pocitadla.nextvalinto :new.id_pocitadlafromdual; 

END 

/ 

CREATE TRIGGER Honza.triger_archiv 

  BEFORE INSERT 

  ON Honza.Archiv 

 FOR EACH ROW 

  BEGIN 

selectseq_archiv.nextvalinto :new.id_archyvfromdual; 

END 

/ 
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15.5 Procedura pro vkládání uživatele 

CREATE PROCEDURE Honza.vlozitUzivatele(Tlogin in Varchar2, 

Tpass in Varchar2, 

Tzvire in Varchar2, 

jmeno in Varchar2, 

prijmeni in Varchar2) 

as 

begin 

declare 

 

cislo NUMBER; 

BEGIN 

    insert intologin(login,pass,zvire) VALUES (Tlogin,Tpass,Tzvire) return id intocislo; 

    insert intouzivatel(jmeno,prijmeni,id_login,id_adresa) 

    VALUES (Tjmeno,Tprijmeni,cislo,null)  ; 

    insert intoPlatny_Login(platny,id_login) 

    VALUES ("0",cislo); 

END  ; 

end vlozitUzivatele; 

/ 
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16 Hosting webové prezentace 

Na webovou prezentaci je možné přistoupit pomocí následující adresy: 

http://orcad.kvalitne.cz/ 

Spravovat webovou prezentaci lze dvojím způsobem. Buď pomocí webového rozhraní, 

vytvořeného daným hostingovým centrem, nebo pomocí klientů, komunikujících přes FTP. 

S oblibou využívám klienta Total Commander. Na následujícím obrázku (Obrázek 16)  

je příklad jeho nastavení. 

 

Obrázek 16 – Příklad nastavení Total Commanderu 

 

http://orcad.kvalitne.cz/
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17 Videa u podstatných částí práce 

Dlouho jsem bádal nad tím, jak zhotovovat videa. Nakonec se mi to podařilo pomocí 

programu Camtasia Studio ve verzi 7.1.0 (Obrázek 17), jenž mi velice usnadnil práci. 

Jedná se o pohodlný program, umožňující snímat obrazovku počítače v různých kvalitách  

a následně upravovat a poskytovat videa např. na YouTube. 

Orientace v programu je velice snadná i pro uživatele, kteří neumí anglicky, díky 

standardizovaným ikonám. Pravá horní část programu slouží pro práci s videem. Levá část 

nabízí soubory pro práci se zachycenými videi. Do takto načteného videa můžeme přidávat 

různé efekty, případně texty. Dolní část obsahuje časovou osu našeho videa se změnami, 

které jsme během práce provedli. Program umí nahrávat videa dokonce i v HD kvalitě. 

Před vytvořením nahrávky má uživatel možnost zvolit, zda bude nahrávat zvuk, případně 

jaká část obrazovky bude snímaná (Obrázek 18). Samotné nahrávání jsem realizoval 

pomocí výřezu obrazovky v HD rozlišení, protože možnost nastavení rozlišení obrazovky 

mi neumožnilo nastavit rozlišení 1280 x 720 px (HD). 

 

Obrázek 17 – Prostředí Camtasia Studio 7.1.0 
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17.1 Uložení na YouTube.com 

Videa, která byla v prostředí Camtasia pořízena, bylo třeba někde uložit. Jako nejvhodnější 

uložiště jsem si zvolil YouTube. Jedná se o celosvětové a největší uložiště hudby a videí. 

Uživatelé mají možnost jednotlivá videa hodnotit a komentovat, což je jeden z důvodů, 

proč jsem toto uložiště zvolil. Délka videí se pohybuje okolo 10 minut. Takto uložená 

videa si následně vložím přímo do své stránky a to díky skvělému prohlížeči, jež YouTube 

nabízí. 

 

Obrázek 18 – Nahrávací panel 
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Závěr 

Cílem této práce bylo vytvořit ucelený studijní materiál, který má posluchače uvést  

do problematiky moderních návrhů plošných spojů pomocí výpočetní techniky. Během 

několika podkapitol dvou hlavních bloků, které tvoří Capture a Layout, se student má 

možnost seznámit s informacemi, jež tvoří velkou část práce. Po skončení bloku následuje 

práce, která by měla otestovat získané znalosti. Hlavní důraz byl kladen na multimediální 

ukázky a vývoj přiložených souborů. V tabulkách obsahujících jednotlivé značky bylo 

cílem seznámit návrháře s tím, co vlastně kreslí. 

V části, kde dochází ke kreslení plošného spoje, jsem se pokoušel na multimediální ukázce 

nastínit různé alternativy manipulace s jednotlivými součástkami, což považuji za velice 

přínosné a užitečné, stejně jako realizaci vícevrstvých plošných spojů v části Layout. 

V technické dokumentaci není však možné zobrazit a ukázat úplně všechny části práce. 

Proto doporučuji zhlédnout přiložená videa v praktické části práce. 

Webová a částečně databázová část práce byla nejtěžší. Hlavně vymyslet způsob,  

jak co nejpřehledněji a efektivněji editovat aplikované informace. Od databázové části 

aplikace jsem očekával získání názorů o daném projektu spolu s přehledem o uživatelích, 

jež projekt využívají. Databázová část je navržena tak, aby dostatečně vyhovovala 

charakteru a významu práce.  

Hlavní přínos této práce vidím v aplikaci OrCAD, protože jak už bylo zmíněno na začátku, 

plošné spoje jsou prostě všude kolem nás. Stále bude potřeba navrhovat DPS, zhotovovat 

nová složitější zařízení. Doby, kdy k návrhu plošného spoje stačila tužka a papír, jsou už 

dávno pryč a programů, které navrhování umožňují, není mnoho a většinou se jedná  

o publikace v cizím jazyce, čímž nejsou pro část technické veřejnosti použitelné. 

Během minulého studia jsem se zabýval klasickou elektronikou (rádia, televize, …)  

a složením těchto zařízení, proto jsem si toto téma zvolil – mám k tomu poměrně blízko. 

Své dřívější znalosti jsem se snažil maximálně aplikovat, aby dílo mělo hlubší význam. 

Jistě by se našla spousta dalších klávesových zkratek a možností, jak s programem OrCAD 

pracovat, ale vzhledem k rozsahu práce je nemožné popsat a znát naprosto vše.  

Věřím, že Vás kreslení plošných spojů neodradí a snadno zvládnete nakreslit jakýkoli 

plošný spoj, který Vám bude zadán ať už s vlastní pomocí nebo pomocí elektronického 

průvodce, či jiných užitečných zdrojů.  
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Příloha A – Samostatná práce po části Capture 
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Příloha B – Správně převedený netlist nehlásící chyby 
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Příloha C – Diagram aktivit pro anketu 
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Příloha D – Diagram případů užití 
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Příloha E – Diagram tříd pro odesílání emailu 
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Příloha F – Diagram tříd pro aplikaci 
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Příloha G – Vyjádření problémové situace 

 


